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Each lesson has its own 
folder inside the Lessons 
folder. You will need to copy 
these lesson folders to your 
hard drive before you can 
begin each lesson.

Lesson files

The Adobe Premiere Elements 11 Classroom in a Book disc includes the lesson files 

that you’ll need to complete the exercises in this book, as well as other content to 

help you learn more about Adobe Premiere Elements 11 and use it with greater 

efficiency and ease. The diagram below represents the contents of the disc, which 

should help you locate the files you need.

WHAT’S ON THE DISC
Here is an overview of the contents of the Classroom in a Book disc

Online resources

Adobe Press

Links to Adobe Community 
Help, product Help and 
Support pages, Adobe 
Press, Adobe certification 
programs, Adobe TV, and 
other useful online resources 
can be found in a handy 
HTML file. Just open it in 
your web browser and click 
the links, including a special 
link to this book’s product 
page where you can access 
updates and bonus material.
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Find information 
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in the Online 
Resources file.
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ADOBE PREMIERE ELEMENTS 11 CLASSROOM IN A BOOK 1

Adobe® Premiere® Elements 11 delivers video editing tools that balance power 

and versatility with ease of use. Adobe Premiere Elements 11 is ideal for home 

users, hobbyists, business users, and professional videographers—anyone who 

wants to produce high-quality movies and DVDs.

If you’ve used earlier versions of Adobe Premiere Elements, you’ll find that 

this Classroom in a Book covers the updated interface that Adobe Systems 

introduced in this version, plus new advanced skills and features. If you’re new 

to Adobe Premiere Elements, you’ll learn the fundamental concepts and tech-

niques that will help you master this application.

About Classroom in a Book

Adobe Premiere Elements 11 Classroom in a Book is part of the official training 

series for Adobe graphics and publishing software developed by Adobe prod-

uct experts. Most lessons in this book include self-paced projects that give you 

hands-on experience using Adobe Premiere Elements 11.

Adobe Premiere Elements 11 Classroom in a Book includes a DVD attached to 

the inside back cover. On the DVD, you’ll find all the files used for the lessons 

in this book. You will almost certainly get the most benefit from working on 

the lessons in the order in which they occur in the book.

As an overview, in the first two lessons, you’ll learn your way around Adobe 

Premiere Elements’ and the Adobe Organizer’s interfaces, how to set up a proj-

ect in Adobe Premiere Elements, and how to customize critical preferences. 

In Lesson 3, you’ll learn how to capture and otherwise import video into 

Adobe Premiere Elements. Starting with Lesson 4 and continuing through 

Lesson 12, you’ll open projects on the DVD or create your own from con-

tents on the disc, and learn how to convert your raw, captured clips into a 

polished movie.

Note that the project files had to be created separately for Mac and Windows 

computers, and were created using pre-release software and content. For this 

reason, there may be some minor differences between the screens in the book 

GETTING STARTED



2 GETTING STARTED

and what you might see onscreen when you’re using Adobe Premiere Elements. 

Inside the book, we tried to identify the most likely places for this to happen but 

want to apologize in advance for any differences or inconvenience. 

Prerequisites

Before you begin working on the lessons in this book, make sure that you and your 

computer are ready.

Requirements for your computer

You’ll need a maximum of about 4.3 gigabytes (GB) of free space on your hard drive 

for the lesson files and the work files you’ll create. For some lessons, you’ll need to 

have 2 GB of RAM installed on your computer. Note that the lessons assume that 

you have installed all templates and associated content available with the DVD 

version of Adobe Premiere Elements 11 and via download. If you see a template 

that’s not installed on your computer, you should be able to simply choose another 

template and continue with the lesson. 

Required skills

The lessons in this Adobe Premiere Elements 11 Classroom in a Book assume that 

you have a working knowledge of your computer and its operating system. This 

book does not teach the most basic and generic computer skills. If you can answer 

yes to the following questions, you’re probably well qualified to start working on the 

projects in these lessons: 

• Do you know how to use the Microsoft Windows Start button and the Windows 

task bar? On the Mac, do you know how to run applications from the Dock or 

in the Applications folder? In both operating systems, can you open menus and 

submenus, and choose items from those menus?

• Do you know how to use My Computer, Windows Explorer, Finder, and/or 

a browser—such as Chrome, Firefox, Internet Explorer, or Safari—to find items 

stored in folders on your computer, or to browse the Internet? 

• Are you comfortable using the mouse to move the pointer, select items, drag, 

and deselect? Have you used context menus, which open when you right-click 

items in Windows or Mac OS, or Control-click items on the Mac if you’re 

working with a single-button mouse?
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• When you have two or more open applications, do you know how to switch 

from one to another? Do you know how to switch to the Windows or 

Macintosh desktop?

• Do you know how to open, close, and minimize individual windows? Can you 

move them to different locations on your screen? Can you resize a window 

by dragging?

• Can you scroll (vertically and horizontally) within a window to see contents that 

may not be visible in the displayed area?

• Are you familiar with the menus across the top of an application and how to use 

those menus? 

• Have you used dialogs (special windows in the interface that display 

information), such as the Print dialog? Do you know how to click arrow icons 

to open a menu within a dialog?

• Can you open, save, and close a file? Are you familiar with word-processing 

tasks, such as typing, selecting words, backspacing, deleting, copying, pasting, 

and changing text?

• Do you know how to open and find information in Microsoft Windows or 

Apple Macintosh Help?

If there are gaps in your mastery of these skills, see the documentation for your 

operating system. Or, ask a computer-savvy friend or instructor for help. 

Installing Adobe Premiere Elements 11

Adobe Premiere Elements 11 software (sold separately) is intended for installation 

on a computer running Windows XP, Windows Vista, or Windows 7, or Mac OS 

10.5x or later. For system requirements and complete instructions on installing the 

software, see the Adobe Premiere Elements 11 application DVD and documenta-

tion. To get the most from the projects in this book, you should install all the tem-

plates included with the software. Otherwise, you may notice “missing file” error 

messages.
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Copying the Classroom in a Book files

The DVD attached to the inside back cover of this book includes a Lessons folder 

containing all the electronic files for the lessons in this book. Follow the instruc-

tions to copy the files from the DVD, and then keep all the lesson files on your 

computer until after you have finished all the lessons.

Copying the lesson files from the DVD

1 Insert the Adobe Premiere Elements 11 Classroom in a Book DVD into your 

DVD-ROM drive. Open the DVD in My Computer or Windows Explorer 

(Windows), or in the Finder (Mac OS).

2 Locate the Lessons folder on the DVD and copy it to any convenient folder on 

your computer. Just remember where you copied it, because you’ll be opening 

the lesson files frequently throughout the book. In the Lessons folder, you’ll 

find individual folders containing project files needed for the completion of 

each lesson.

3 When your computer finishes copying the Lessons folder (which could take 

several minutes), remove the DVD from your DVD-ROM drive, and store it in 

a safe place for future use. 

Additional resources

Adobe Premiere Elements 11 Classroom in a Book is not meant to replace docu-

mentation that comes with the program or to be a comprehensive reference for 

every feature. Only the commands and options used in the lessons are explained in 

this book. For comprehensive information about program features and tutorials, 

please refer to these resources.

Adobe Community Help: Community Help brings together active Adobe product 

users, Adobe product team members, authors, and experts to give you the most 

useful, relevant, and up-to-date information about Adobe products. 

To access Community Help: To invoke Help, press F1 or choose Help > Premiere 

Elements Help. 

Adobe content is updated based on community feedback and contributions. You 

can add comments to both content and forums, including links to web content. Find 

out how to contribute at www.adobe.com/community/publishing/download.html.

See community.adobe.com/help/profile/faq.html for answers to frequently asked 

questions about Community Help.

http://www.adobe.com/community/publishing/download.html
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Adobe Premiere Elements 11 Help and Support: Point your browser to  

www.adobe.com/support/premiereelements where you can find and browse 

Help and Support content on adobe.com.

Adobe Forums: forums.adobe.com lets you tap into peer-to-peer discussions and 

questions and answers on Adobe products.

Adobe TV: tv.adobe.com is an online video resource for expert instruction and 

inspiration about Adobe products, including a How To channel to get you started 

with your product.

Adobe Design Center: www.adobe.com/designcenter offers thoughtful articles 

on design and design issues, a gallery showcasing the work of top-notch designers, 

tutorials, and more.

Adobe Developer Connection: www.adobe.com/devnet is your source for techni-

cal articles, code samples, and how-to videos that cover Adobe developer products 

and technologies.

Resources for educators: www.adobe.com/education offers a treasure trove of 

information for instructors who teach classes on Adobe software. Find solutions 

for education at all levels, including free curricula that use an integrated approach 

to teaching Adobe software and can be used to prepare for the Adobe Certified 

Associate exams.

Also check out these useful links:

Adobe Marketplace & Exchange: www.adobe.com/cfusion/exchange is a central 

resource for finding tools, services, extensions, code samples, and more to supple-

ment and extend your Adobe products.

Adobe Premiere Elements 11 product home page:  

www.adobe.com/products/premiereel.

Adobe Labs: http://labs.adobe.com gives you access to early builds of cutting-edge 

technology, as well as forums where you can interact with the Adobe  development 

teams building that technology and other like-minded members of the community.

Free trial versions of Adobe Photoshop Elements 11 and Adobe Premiere 

Elements 11: The trial version of the software is fully functional and offers every 

feature of the product for you to test-drive (does not include Plus membership). 

To download your free trial version, browse to http://adobe.ly/NBGbfD.

http://www.adobe.com/support/premiereelements
http://www.adobe.com/designcenter
http://www.adobe.com/devnet
http://www.adobe.com/education
http://www.adobe.com/cfusion/exchange
http://labs.adobe.com
http://www.adobe.com/products/premiereel
http://adobe.ly/NBGbfD
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ORGANIZING YOUR CONTENT

Lesson overview

Fast and efficient movie production requires organization before and 

during the edit. To help you organize your editing work in Expert 

view, Adobe Premiere Elements’ Project Assets panel lets you search 

for and deploy content already added to your project.

However, when you’re working with content from multiple sources 

and dates, Adobe Organizer is a very powerful tool for categoriz-

ing your content and quickly finding video, audio clips, and pictures 

to use in your projects. In this lesson, you’ll learn how to do the 

following:

• Create Places in the Organizer and associate your content with 

those places

• Use Smart Events to quickly find content from specific dates

• Create Events in the Organizer and associate your content with 

those events

• Rate your clips and find clips based on those ratings

• Create and use keyword tags to find your content

• Use the Auto-Analyzer to split your video into scenes and rate it 

qualitatively

• Transfer clips from the Organizer to Adobe Premiere Elements

This lesson will take approximately two hours.

4
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Geotagging content in the Organizer.
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Getting started

Before you start working with the footage, let’s review a final version of the movie 

you’ll be creating. Make sure that you have correctly copied the Lesson04 folder 

from the DVD in the back of this book onto your computer’s hard drive. See 

“Copying the Classroom in a Book files” in the “Getting Started” section at the 

beginning of this book.

1 Launch Adobe Premiere Elements. If it is already open, choose Help > Welcome 

Screen in the Adobe Premiere Elements main menu to return to the Welcome 

screen.

2 In the Welcome screen, click Video Editor, select Existing Project, and click the 

Open folder.

3 In the Open Project dialog, navigate to the Lesson04 folder you copied to 

your hard drive. Within that folder, select the file Lesson04_Start_Win.prel 

(Windows) or Lesson04_Start_Mac.prel (Mac OS) and then click Open. 

If a dialog appears asking for the location of rendered files, click the Skip 

Previews button.

Your project file opens.

4 Choose Window > Restore Workspace to ensure that you start the lesson with 

the default panel layout.

Viewing the completed 
movie before you start

To see what you’ll be creating in this lesson, you can take a look at the completed 

movie. You must be in Expert view to open the Project Assets panel to view the 

movie; if you are not, click Expert on the top of the Monitor panel ( ) to enter 

that view.

1 On the upper-left side of the Adobe Premiere Elements interface, click the 

Project Assets button ( ) to open that panel. Locate the file Lesson04_

Movie.mov (which should be the only file), and then double-click it to open the 

video into the preview window.



ADOBE PREMIERE ELEMENTS 11 CLASSROOM IN A BOOK 69

2 Click the Play button ( ) to watch the video about powering the Space Shuttle 

(all footage was graciously provided by NASA), which you’ll build in this lesson.

3 When you’re finished, close the preview window.

Working in the Project Assets panel

The Project Assets panel contains all the content that you’ve input into your project 

and is only available in Expert view. As with all panels, you click the Project Assets 

button ( ) to open it and then click the button again to close it.

The Project Assets panel’s role is to help you organize and find files using different 

search methods. Let’s load some files into the project so you can work with them 

in the Project Assets panel. Again, if you don’t see the Project Assets panel, click 

Expert on the top of the Monitor panel ( ) to enter that view.

1 Click Add Media ( ) to open the Add Media panel.

2 Click Files and folders ( ) to open the Add Media dialog.

3 Navigate to the Lesson04 folder. While pressing the Ctrl key (Windows) or 

Command key (Mac OS), select the movie clips Video 1.mp4 to Video 12.mp4, 

all digital pictures from Picture 1.jpg to Picture 7.jpg, and the single audio clip, 

narration.wav. Then click Open (Windows) or Import (Mac).
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Controls in the Project Assets panel

You can also use controls in the Project Assets panel to create titles, black videos, 

bars and tones, and color mattes. In this short section, you’ll learn how to use the 

basic tools in the Project Assets panel to find the desired file.

You can perform the following activities in the Project Assets panel to view 

your files:

• Grab the handle on the extreme lower right of the panel to expand it vertically 

and horizontally.

• Browse through the entire catalog by using the scroll bar at the right side of 

Project Assets panel.

CA B D E F G H

A. Show/Hide Video

B. Show/Hide Still Image

C. Show/Hide Audio

D. Search box

E. Go up one folder level

F. Clear

G. Pin view

H. Project Assets menu

Let’s work through some of the most common functions of the Project Assets 

panel.

1 On the upper left of the Project Assets panel, experiment by clicking the 

Show/Hide Video ( ), Show/Hide Still Image ( ), and Show/Hide Audio ( ) 

buttons. For example, click the Hide Still Image and Hide Audio buttons so only 

video files appear in the Project Assets panel. This is a very simple technique for 

quickly finding the video content that you’re looking for.
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2 From the Project Assets panel menu, choose View > List view to display the 

content in this view. Once in List view, click and drag the bottom-right corner 

to expand the window so all the columns are visible. You can sort your content 

by clicking the column head of any column. The arrow in the column you 

choose shows whether the data is sorted in ascending order or descending 

order. For example, click the Name column head to see how it sorts the content, 

and then click the Media Duration column head.

3 In the Project Assets panel menu, choose New Folder to create a folder to 

organize your videos. Adobe Premiere Elements creates a folder named 

Folder 01 with the text highlighted so it’s easy to change the name. Type in the 

word Videos and press Enter or Return, replacing the text Folder 01.

4 Select all files and drag them into the new folder. Click the disclosure triangle 

next to the Videos folder to close it. Your Project Assets panel is a whole lot 

tidier. When you’re working with large projects with multiple video, still image, 

and audio files, creating folders is the best strategy for organizing your content 

and making it easy to find.
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5 From the Project Assets panel menu, choose New Item to view the new items 

that you can create from this menu. We’ll cover titles in Lesson 8. Bars and Tone 

is a vestigial concept that is useful for analog projects but has little application 

for most digital video-based projects. Creating black video and color mattes are 

useful when you need colored or black backgrounds for titles or other movie 

elements. Select any of these items and Adobe Premiere Elements will open a 

format-specific dialog for creating the content and inserting it into the Project 

Assets panel.

6 Double-click Video 1.mp4 in the Videos folder of the Project Assets panel to 

open it in the preview window. (If necessary, click and drag the bottom-right 

corner of the Project Assets panel to make the preview window visible.) The 

preview window lets you play your content using VCR-like controls before you 

add it to your project. You can also trim frames from the start and end of the 

video before adding it to your project. Although you can also trim frames in the 

timeline, you may prefer to do this in the preview window.

7 Let’s trim some frames from the clip. In the Preview window, drag the 

current-time indicator to the right until the timecode beneath the video reads 

00;00;00;09 (see figure on following page), which is nine frames in from the start 

of the clip and the point at which you can just start to see flames beneath the 

Space Shuttle’s solid rocket boosters. Note that you can also use the left and 

right arrow keys on your keyboard for precise positioning of the current-time 

indicator.

8 Click the Set In icon to set the In point, or press the letter I on your keyboard. 

In essence, you’ve told Adobe Premiere Elements to ignore the first nine frames 

when you add the clip to the project and start at frame 10. Of course, the edit 

is nondestructive, so you haven’t actually deleted any frames from the video file 

on your disk. You can always undo this later and show the frames that you just 

trimmed.

� Note: On Windows, 
you can also create a 
Universal Counting 
Leader, a vestigial 
feature typically used 
only when writing video 
back to analog tape.
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A D E F G H J K LIB C

A. Current-time indicator

B. In point handle

C. Current time in movie

D. Rewind

E. Set In point (I)

F. Step Back (left arrow key)

G. Play/Pause toggle (spacebar)

H. Step Forward (right arrow key)

I. Set Out point (O)

J. Fast-Forward

K. Clip duration

L. Out point handle

� Note: Rather than moving the current-time indicator to the desired location and choosing Set In 
point or Set Out point, you can simply drag the In point handle or Out point handle to the desired 
location.

9 In the preview window, drag the current-time indicator to the right until the 

timecode beneath the video reads around 00;00;04;05, which is where the 

Shuttle’s nose touches the top of the video frame. Click the Set Out icon to set 

the Out point, or press the letter O on your keyboard. You’ve just set the Out 

point, essentially trimming out all video frames to the right of that point of 

the video.



74 LESSON 4 Organizing Your Content

10 Click and drag Video 1 in the preview window to the start of the Video 1 and 

Audio 1 tracks on the timeline as shown in the figure and release. You’ve just 

added the trimmed video to the timeline. Click No if Adobe Premiere Elements 

asks if you want to fix any quality issues in the clip or any other questions.

11 Close the preview window, and then click the Project Assets ( ) button 

to close the Project Assets panel. Make sure that the current-time indicator in 

the timeline is at the start of the clip, click anywhere in the timeline, and then 

press the spacebar to play the clip. Note that it starts and ends on the trimmed 

frames.

� Note: When you set In and Out points in the preview window, they’re automatically applied 
prospectively when you drag the clip into the timeline. But these In and Out points aren’t 
retroactively applied to clips already in the timeline. You’ll learn how to trim clips in the timeline in 
the next lesson.
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Tagging in the Organizer

The Project Assets panel is great for quickly finding clips, but the Organizer is 

Adobe Premiere Elements’ best tool for serious organization and search-and-

retrieval work. You can open the Organizer by clicking the Organizer icon ( ) 

in Adobe Premiere Elements’ Action bar. This exercise details how to perform 

manual and Smart Tagging in the Organizer, and then how to search for clips using 

those tags in the Organizer.

Star ratings
Manual tagging 
with Keyword Tags

Smart TaggingMedia browser

People, Places, 
and Events

As shown in the figure, there are three ways that the Adobe Organizer helps you 

organize your clips: by categorizing them into People, Places, and Events; by giving 

them star ratings on a scale from 1 to 5; and by manually tagging them with key-

words and via smart tags. Let’s take a quick look at each technique in this introduc-

tory overview, and then you’ll learn how to use them.

In Adobe Premiere Elements 11, the Organizer’s interface has been optimized for 

three views, as shown on the top toolbar: People, Places, and Events. By associat-

ing your video clips with one or more of these categories, you can easily find all 

clips associated with a person, place, or event. I’ll demonstrate how to associate 
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your clips with a place or an event, but not a person, primarily because face 

 recognition—a great feature that the Organizer uses to automate the process of 

people tagging your still images—is not available for video.

The star ratings system allows you to review and rate all your clips on a scale 

from 1 to 5; you can later search for only those clips that you rated 4 or higher, for 

example—an easy way to find high-quality clips and eliminate poor-quality clips. 

Keyword tags allow you to tag a clip by person, location, event, or other tags and 

includes customizable categories.

When you run the Auto-Analyzer on a clip, Adobe Premiere Elements analyzes 

the video to detect scenes based on content and rates the content qualitatively, a 

process known as Smart Tagging. This allows you to hunt for scenes with faces and 

identify scenes that are out of focus, shaky, underexposed, or overexposed. Using 

this qualitative data, Adobe Premiere Elements then categorizes all clips as high, 

medium, or low quality. This serves a valuable triage function that you can later 

use to search for the best clips for your movie. This analysis is also used for features 

like Smart Trimming, which you’ll learn in Lesson 5, and Smart Fix, as discussed in 

Lesson 6.

For example, if you shot an hour of video on your last vacation, Smart Tagging 

allows you to identify medium-quality-and-higher clips containing faces (presum-

ably family members) and produce a movie containing only these clips. What 

would literally take you hours to accomplish manually, Smart Tagging can produce 

in a few moments.

Using all these tags in any combination, you can hunt for clips to manually add to 

your projects or create an InstantMovie, which is a professional-looking edited 

movie complete with titles, soundtrack, effects, and transitions. You’ll create an 

InstantMovie in the last exercise in this lesson.

Tagging clips in the Organizer

Let’s dive into tagging clips in the Organizer, starting with Places and Events. If 

you’ve been following along, your Organizer should just have the content loaded 

from the Lesson04 folder. To ensure that we’re all looking at the same thing, let’s 

reload that content.

1 On the bottom-left corner of the Organizer, click the Show button ( ) to open 

the panel. The Show button toggles to the Hide button ( ).

2 If necessary, click the disclosure triangle next to My Folders to reveal that 

content. Then click Lesson04. If Lesson04 isn’t there, return to the “Working 

in the Project Assets panel” exercise and load the content as described. Then 

return to this exercise; the Lesson04 folder should be there.
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3 Take these steps to make sure your Organizer looks the same as the figure.

• In the Organizer menu, choose View > Media Types. Make sure photos, 

video, and audio are all selected.

• Choose View > Details, View > File Names, and View > Grid Lines to show 

these elements.

• In the Sort By list box on top of the Organizer’s Media browser, make sure 

Oldest is selected.

� Note: If you’ve been working with Adobe Premiere Elements and the Organizer for a while, you’ll 
likely have multiple projects and folders in the panel. Find and click the Lesson04 folder; the content 
in the Organizer should be close to what you see in the figures.

Now that we’re all looking at the same screen, let’s start tagging.

� Note: The Adobe Organizer can display all clips in a Timeline view (in Media view, click View > 
Timeline) that displays content by data, which can be a convenient way to find some clips. You just 
move along the timeline, click any clumps of sequential clips in the timeline, and they appear in 
the Media browser. Of course, you need clips in the Organizer to create the clumps, so until you 
populate the Organizer, this view won’t provide that much value.

� Note: You can 
play any video file in 
the Organizer or view 
any still image in the 
Organizer by double-
clicking the video or still 
image in the browser 
and then clicking the 
Play button in the 
preview window that 
appears. Close the 
window to return to 
the Media browser. Still 
images are displayed in 
an expanded window in 
the Media browser; click 
Grid ( ) on the left of 
the toolbar immediately 
above the image to 
return to the Media 
browser.

� Note: Your screen 
may not match 
perfectly what’s shown 
on the page, but the 
minor differences 
shouldn’t keep you 
from completing any 
exercises.
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Tagging clips to Places

The NASA clips we’re using in this book took place in two basic places: The launch 

occurred at Kennedy Space Center in Florida, and the other location is somewhere 

in outer space that, as near as I can tell, Google hasn’t yet incorporated into Google 

Earth. Give it time. Even though the launch and landing took place at Kennedy 

Space Center, because over 50 Shuttle landings have occurred at Edwards Air Force 

Base in California and we want to tag two different places in this exercise, we’ll tag 

the landing at Edwards Air Force Base.

At a high level, you’ll create two Places in the Organizer—one for launch and one 

for landing—and then associate some clips with each place. Then, working from 

the Organizer’s Google Maps view, you can click a place and see all clips associated 

with that place. Let’s jump in.

1 On the Organizer’s top toolbar, click Places ( ).

2 On the Organizer’s bottom toolbar, click Add Places ( ).

3 In the Add Places Search field, type Kennedy Space Center and click Search. 

Note that if you were typing in a street address, you would type in the address 

as you would on an envelope. For example, if you shot video at the White 

House in Washington, DC, you could either type in The White House or 1600 

Pennsylvania Avenue, NW Washington, DC 20500.

4 If Google Earth finds two locations, click John F. Kennedy Space Center, Florida, 

USA, not the Visitor Center. The Organizer will create a placeholder into which 

you will drag all media shot from that location.

5 Hold down the Ctrl key (Windows) or Command key (Mac OS) and click all 

the pictures and video in the media bar atop the Add Places dialog associated 

with that location. Our selections don’t have to match precisely, but I selected 

all take-off related pictures and videos that showed the Shuttle on or near the 

ground, and didn’t select space or landing shots. This totaled six videos.
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6 Release the Ctrl key (Windows) or Command key (Mac OS), click any of the 

selected pictures or video, drag them all to the icon beneath the Place 6 Media 

Here text box, release the pointer, and click the green checkmark. Adobe 

Premiere Elements will associate the selected content with that place.

7 On the bottom right of the Add Places dialog, click Done. The Organizer creates 

the place.

8 Repeat the process with the landing shots. Click Add Places again, type 

Edwards Air Force Base in the Search field, and click the location that the 

Organizer finds. Ctrl-click (Windows) or Command-click (Mac OS) the three 

landing shots (two similar landing videos and one still-frame night landing), 

release the Ctrl key (Windows) or Command key (Mac OS), and drag the 

selected content into the icon. Click Done when you’re finished.

You should now have at least two places identified and content associated with 

each. Let’s see how this will help you find your content for future projects.

In the Organizer’s top toolbar, click Media ( ) to exit Places view, and then 

click Places ( ) to return to that view. If the Map isn’t displayed on the right, 

click the Map icon ( ) in the lower-right corner of the Organizer interface.
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You may have to adjust the navigational and sizing controls on the upper left of the 

map, but you should be able to approximate the view shown in the previous figure. 

Double-click either icon, and the Organizer will display the content from that loca-

tion in the Media browser, as shown in the figure above. Single-click the icon, and 

the Organizer will display all content with the content from that location high-

lighted. If you hover your pointer over the blue icon in each video or still image, 

you’ll notice that it’s been tagged to the respective places.

Tagging clips to Events

The Organizer has a Smart Events feature that you can use to find content without 

any tagging on your part. To see this function in action, click Events ( ), and 

then choose the Smart Events toggle in the Events top toolbar. This shows all con-

tent grouped by date in the Media browser, which you can navigate through using 

the vertical scroll bar on the right of the Media browser. Or, you can narrow your 

search by choosing a year, month, and/or day using the calendar on the right.

� Note: Note that 
Places has a Map view, 
shown in the previous 
figure, and a List view, 
which might provide 
better precision for 
certain search functions.
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Sometimes, however, you’ll want to manually organize clips into Events—perhaps 

because like the Shuttle flight, the event took place over multiple days. Or, perhaps 

you shot video and pictures at more than one event on a particular day and need to 

break them into multiple events, like a wedding ceremony and wedding reception. 

Here’s the procedure for manually creating Events with the Adobe Organizer. For 

the purposes of this exercise, though our clips were gathered from multiple mis-

sions, I’ll assume that the Space Shuttle mission was STS-135, the last mission flown.

1 Click Events ( ) to enter Event view. Make sure Events is selected in the top 

toolbar, not Smart Events.

2 On the Organizer’s bottom toolbar, click Add Event ( ). The Add New Event 

dialog appears on the right.

3 Complete the information in the Add New Event dialog.

• In the Name field, type STS-135.

• Use the calendar controls to input a Start Date of 7/8/2011 and an End Date 

of 7/21/2011. It’s easiest if you choose the year first and then the date.

• In the Description field, type Final Space Shuttle Mission.

4 Assuming that you still have Lesson04 selected in the panel on the left, all 

content in the Media browser should relate to this mission. Click anywhere in 

the media window to select that window, and then press Ctrl+A (Windows) 

or Command+A (Mac OS) to select all the content in the Media browser, 

drag it into the window beneath the description, and release your pointer. The 

Organizer adds this content to the mission event.

5 On the bottom right of the Add New Event dialog, click Done. The Organizer 

creates the event.

� Note: While these 
missions actually 
occurred and the videos 
were shot in 2011 and 
before, the media files 
that we’re using were 
created from NASA 
sources in 2012. So 
don’t let the dates in the 
figure confuse you.
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Let’s see how this will help you find your content later on. In the Organizer’s top 

toolbar, click Media ( ) to exit Events view, and then click Events ( ) to return 

to that view. You should see the STS-135 event in the Media browser window. If you 

double-click it, the clips that you associated with the event will appear in the Media 

browser. If you hover your pointer over the calendar icon for a particular clip in the 

Media browser, you’ll see the event with which it has been associated.

Working with star ratings

As mentioned earlier, star ratings allow you to manually rate your clips on a scale 

from 1 to 5 and then search for clips based on those ratings. Follow these proce-

dures to apply and delete star ratings, and to search for clips based on the star rat-

ings. Ratings range from 1 (on the extreme left) to 5 (on the extreme right).

1 Click Media to return to Media view. If you don’t see the star ratings for your 

clips, choose View > Details in the Organizer menu.

2 Hover your pointer over the star ratings beneath any clip, and click the star 

that corresponds to the desired rating for that clip. Go ahead and rate a few 

clips so you can sort by rating in step 5. These are all five-star clips as far as I’m 

concerned, but go ahead and rate some across the board.

3 To change a rating, use the same procedure and choose a different rating.
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4 To delete the star rating, click the last selected star on the right (the fourth star 

in a clip rated four stars).

5 To find clips based on their assigned ratings, click the number of target stars 

in the star Ratings bar on the top right, and in the drop-down list beneath the 

ratings, choose how to apply the rating. For example, in the next figure, we 

elected to show all clips with a four-star rating or higher.

6 To stop sorting by star rating and show all clips in the Organizer, delete the star 

rating on the upper right by clicking the last selected star.

Working with Keyword Tags

Adobe Premiere Elements includes general categories of Keyword Tags that you 

can apply as is or customize with your own categories or subcategories. In this 

lesson, you’ll create and apply a custom keyword in the Organizer, and then search 

for clips based on that keyword. To ensure that you’re looking at the same content 

as appears in this book, make sure you’ve selected the Lesson04 folder in the My 

Folders section of the Albums and Folders panel on the left of the Organizer. See 

the first few steps of the earlier section “Tagging clips in the Organizer” to accom-

plish this.

1 On the bottom right of the Organizer, click Tags/Info ( ) to open the  

Tags/Information panel.

2 Below Keyword Tags in the Organizer,  

click Other.

3 Below Keyword Tags, click the Create New 

button ( ) and choose New Sub-Category.
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4 In the Create Sub-Category panel, type Space  

Shots in the Sub-Category Name field. Then 

click OK.

Adobe Premiere Elements creates the new 

subcategory.

5 Click the orange tag next to Space Shots and 

drag it onto any of the still images or videos 

that show the Space Shuttle in space. In the following figure, I’ve already applied 

the tag to Picture 6.jpg and Picture 5.jpg and am applying it to Picture 4.jpg.

6 To view the clips that you’ve just tagged, click the greater than (>) icon to the 

right of Space Shots, which opens the Tagging Search window that shows 

Keywords on the upper left and the clips that you just tagged in the Media 

browser. This window shows all tags created via keywords as well as the People, 

Places, and Events that you’ve entered into the system. You can select any check 

boxes in any of these categories or combination of categories to include content 

from these sources in the Media browser. You can even apply star ratings to 

further refine your search.

� Note: The screen 
on your computer 
may different slightly 
from what’s shown 
in this screenshot, 
but the differences 
shouldn’t interfere with 
completing the lesson.
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7 In the upper-left toolbar in the Tagging Search window, click the Back button 

( ) to close that search window.

About the Auto-Analyzer

As mentioned earlier, the Auto-Analyzer analyzes your video clips for content and 

quality, and is integral to a number of functions, including Smart Tagging, Smart 

Trimming, and creating InstantMovies, which you’ll learn to do later in this lesson. 

You can run the Auto-Analyzer manually, as you’ll learn in the next section, or run 

it as a background process. In fact, by default, the Auto-Analyzer will run on clips 

that you import anytime your system is running and idle.

To access this preference, 

in the Organizer, choose 

Edit > Preferences > Media-

Analysis (Windows) or Adobe 

Elements 11 Organizer > 

Preferences > Media Analysis 

(Mac OS). In the default 

setting, Adobe Premiere 

Elements will work in the 

background with imported 

media, so when you’re ready 

to edit, you won’t have to wait 

for the Auto-Analyzer to run.
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In most instances on most computers, background operation should work just fine. 

On older, less-powerful computers, and those configured with the minimum RAM, 

background operation may cause a noticeable drag on foreground operations, 

particularly when you’re working with H.264-based, high-definition formats like 

AVCHD and video shot by DSLRs. If you notice any sluggishness in your fore-

ground operations after importing footage or experience any system instability, try 

disabling the Auto-Analyzer as a background operation by deselecting the Analyze 

Media for Smart Tags Automatically check box.

Running the Auto-Analyzer manually

To manually run the Auto-Analyzer and apply Smart Tags to the project clips, 

follow these steps. Again, to ensure that you’re looking at the same content that 

appears in the book, make sure you’ve selected the Lesson04 folder in the My 

Folders section of the Albums and Folders panel on the left of the Organizer. See 

the first few steps of the earlier section “Tagging clips in the Organizer” to accom-

plish this.

1 If the Organizer isn’t open, click the Organizer icon ( ) in the Action 

bar to open the Organizer.  If it’s already open, press Alt+Tab (Windows) or 

Command+Tab to switch to the Organizer.

2 Press Ctrl+A (Windows) or Command+A (Mac OS) to select all clips, and then 

right-click and choose Run Auto-Analyzer. This can take a while, so you might 

want to try one or two clips first.

3 The Organizer starts analyzing the clips and displays a progress bar. The 

duration of the process will vary by clip length, clip format, and the speed of 

your computer. After completion, Adobe Premiere Elements will display a status 

message letting you know that the analysis is complete.
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4 In the Organizer, if necessary, press Ctrl+D (Windows) or Command+D 

(Mac OS) to display file details. A purple tag beneath the clip’s thumbnail 

indicates that Smart Tagging has been applied, and if there are multiple tags 

( ), you can hover your pointer over the tags to see which quality-related tags 

were applied.

5 To remove a tag, right-click the tag in the Organizer and choose Remove. 

Repeat as necessary for other tags.

Working with clips after Smart Tagging

Let’s take a moment to understand what happens to clips after Smart Tagging. To 

review, during Smart Tagging, Adobe Premiere Elements breaks the clip into differ-

ent scenes based on content changes (as opposed to timecode, like DV files); finds 

different types of content, like faces; and rates the quality of each clip based on 

factors like exposure, focus, and stability.

In the Organizer, you’ll know that the clip has been split into multiple scenes if 

there is a Step Forward icon ( ) on the right of the clip. Click that icon, and Adobe 

Premiere Elements displays all scenes separately in the Organizer surrounded by a 

border that’s a different shade of gray from the rest of the Organizer. This lets you 

know that all the scenes are part of a single clip.
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You should see separate scenes in clip Video 6.mp4, although the clip is so short 

that the difference between the scenes is minimal. With most longer, real-world 

clips, you’ll see more distinct scenes and find that scene detection is quite useful.

In the Organizer, you can treat each scene as a separate clip—for example, double-

clicking it to play it in the preview window. You can consolidate all scenes back into 

a single frame by clicking the Step Backward icon to the right of the final scene ( ).

From the Organizer to Adobe Premiere Elements

After you’ve collected the clips you want to use in the Organizer, you have multiple 

options for transferring them to Adobe Premiere Elements. These options include 

the following:

• Send them all to Adobe Premiere Elements to start a new project or for 

insertion at the end of the timeline in an open project. The high-level procedure 

is to select the desired clips, right-click, and choose Edit with Premiere 

Elements Editor. Note that you can select complete clips or segments of clips 

identified by the Auto-Analyzer. The full procedure is documented in “Working 

in the Organizer” in Lesson 1. This option works well for simple projects 

because it adds all content to the timeline quickly.

• Drag the clips into the Project Assets panel. You must be in Expert view for the 

Project Assets panel to be available. Again, the high-level procedure is to select 

the desired clips, and then drag them into the Project Assets panel. This option 

gives you the most flexibility because you can add the content to the timeline in 

any order and at anytime.
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• Create an InstantMovie from the content by selecting it in the Organizer and 

sending it to Adobe Premiere Elements to create the InstantMovie. This is the 

option explored in the next exercise.

Creating an InstantMovie

In this exercise, you’ll create an InstantMovie from the Space Shuttle clips that 

you tagged in a previous exercise. Again, an InstantMovie is a professional-looking 

edited movie complete with titles, soundtrack, effects, and transitions that you’ll 

create by following a simple wizard.

You’ll start in the Organizer, using the video clips you’ve been tagging from the 

Lesson04 folder. Follow the first two steps in “Tagging clips in the Organizer” to 

make sure these clips are the only ones present in the Media browser. In addition, 

close Adobe Premiere Elements to start with a clean slate in that program. Do not 

overwrite the file Lesson04_Start_Win.prel (Windows) or Lesson04_Start_Mac.prel 

(Mac OS): If you want to save your work, please save it under a different name.

1 Let’s start by removing audio and photos from display in the browser. Choose 

View > Media Types > Photos and then choose View > Media Types > Audio to 

remove these media types from the Media browser.

2 Press Ctrl+A (Windows) or Command+A (Mac OS) to select all clips in the 

Media browser, click the Create button ( ) in the upper-right corner of the 

Organizer, and choose InstantMovie ( ).

3 Adobe Premiere Elements launches. If the Format Mismatch dialog opens, click 

Yes to change the project preset to match the clips.

4 If a Save Project dialog opens, name the file Lesson04_InstantMovie.prel and 

save it in the Lesson04 folder.

� Note: You can 
create InstantMovies 
from within Adobe 
Premiere Elements by 
adding the desired 
clips to the timeline in 
either Quick or Expert 
view and clicking the 
Instant Movie button 
on the Action bar. From 
there, the procedure 
is virtually identical to 
what's described here. 
Note that when creating 
an InstantMovie, Adobe 
Premiere Elements 
removes all effects, 
transitions, and titles 
that you’ve added to 
the project, so trim the 
excess content from 
your clips, but don’t 
add these elements 
because they will all be 
eliminated.
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5 If a dialog opens asking if you want to fix problems in the clips, click No.

6 In the “Choose a movie theme” dialog, choose Pan and Zoom and click Next. If 

this theme is not available, choose another theme.

7 Customize the theme as desired. Accept the options as is, or do any or all of the 
following:
• Customize the Opening and Closing Titles.

• Select the Auto Edit check box to have Adobe Premiere Elements analyze 

your clips and edit them to fit the selected theme, which is recommended. If 

you don’t select Auto Edit, Adobe Premiere Elements uses the clips as is and 

doesn’t edit them. Also, choose whether or not to apply the Auto-Analyzer 

to clips that you haven’t previously analyzed.

• Click the disclosure triangle next to Music to open the Music box. In the 

Music box, choose the Theme Music radio button to use the background 

music from the selected theme, or choose the No Music radio button. To use 

your own background music, click the My Music radio button, and then click 

the Browse button to choose the song you want. Then drag the Music/Sound 

FX slider to the desired setting: Drag to the right to prioritize audio captured 

with the video clips and to the left to prioritize the selected background 

music. If you have dialogue in your project that you want to retain (which 

these clips don’t), select the SmartMix check box and Adobe Premiere 

Elements will reduce the volume of the music track when it detects dialogue.

• Click the disclosure triangle next to Speed and Intensity to open the Speed 

and Intensity box. In the Speed and Intensity box, adjust the Effects and 

Cuts sliders as desired.

• Click the disclosure triangle next to Duration to open the Duration box. In 

the Duration box, choose the desired option. Match Music produces a movie 

that matches the duration of the selected music and is recommended. Or, 

you can specify a duration or choose Use All Clips, which uses all clips at 

their original duration with no background music.

� Note: The “Apply to” 
radio buttons become 
active only when you 
apply a theme to clips 
already inserted into the 
timeline, not when you 
create an InstantMovie 
from the Organizer.
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• Click the disclosure triangle next to Sequence to open the Sequence box. 

In the Sequence box, choose Theme Order (recommended), which allows 

Adobe Premiere Elements to use clips as they best match the theme, or 

choose Time/Date, which uses the clips in the order that they were shot.

• Click the disclosure triangle next to Theme Content to open the Theme 

Content box. In the Theme Content box, choose the content to incorporate 

into the InstantMovie and whether to replace any existing content with 

theme-based content. If a content type is grayed out (like the Intro/Closing 

Movie for the Pan and Zoom theme), it is not included in that theme.

• Click the disclosure triangle next to Render Preview to open the Render 

Preview box. In the Render Preview box, click Yes to render a preview of 

the InstantMovie after completion or No to preview it in real time from the 

timeline (recommended).
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8 After selecting your options, click Apply to create the InstantMovie.

• Click No when the InstantMovie dialog opens and asks if you want to select 

more clips.

• Click Yes if a dialog opens and asks if you want to replace user-applied 

effects.

• Click No when Adobe Premiere Elements asks if you want to render the 

movie.

Adobe Premiere Elements creates the InstantMovie and inserts it into the 

timeline.

9 Adobe Premiere Elements adds the InstantMovie to the timeline in consolidated 

form. To separate the InstantMovie into its components to edit them, click to 

select the new InstantMovie in the timeline, right-click, and choose Break apart 

InstantMovie.

10 Use the playback controls in the Monitor panel to preview the InstantMovie. If 

Adobe Premiere Elements asks if you’d like to render effects before playing the 

movie, click Yes if you’d like to see a perfect rendition, although this may take a 

good bit of time, depending on your system. Click No if you have a fast system 

and/or just want to get a quick feel for how the movie looks.

A C D E F G H I J K L M N OB

A. Preview area

B. Add Marker

C. Current time

D.  Go to Previous Edit Point 
(Page Up)

E. Rewind

F. Step Back (left)

G.  Play/Pause toggle 
(spacebar)

H. Step Forward (right)

I. Fast-Forward

J.  Go to Next Edit Point 
(Page Down)

K. Render timeline

L. Fit to Visible timeline (\)

M. Zoom Out (−)

N. Zoom control

O. Zoom In (=)
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Review questions

1 What view must you be in to see the Project Assets panel?

2 What’s the difference between the Organizer that ships with Adobe Premiere Elements 

and the Organizer that ships with Adobe Photoshop Elements?

3 What are the three main content categories in the Organizer?

4 What is Smart Tagging? Are there any situations in which you wouldn’t want to apply 

Smart Tagging?

5 After creating an InstantMovie, how do you break up the movie to edit it further?

Review answers

1 You must be in Expert view. The Project Assets panel does not appear in Quick view.

2 This is a trick question; there is no difference. If you have Adobe Premiere Elements 

and Adobe Photoshop Elements installed, both programs can insert content into the 

same shared database and sort through and retrieve data from that database.

3 The main content categories in the Organizer are People, Places, and Events.

4 When you apply Smart Tagging to a clip, Adobe Premiere Elements analyzes the clip 

to detect scenes based on content; searches for specific content types, like faces; and 

ranks the quality of your clips. Other than processing time, there’s very little downside 

to applying Smart Tagging. Your video clips will be divided into useful scenes, and you 

can find high-quality clips much faster than you could manually.

5 Click the clip with your pointer to select it, and then right-click and choose Break 

apart InstantMovie.
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SYMBOLS AND NUMBERS

, (comma key), for adding clips, 113

\ (backslash) key

Quick view and, 13

showing entire project, 237

in SmartFix, 136

spreading images with, 305

in timeline, 192

4-pin IEEE 1394 400 connectors, 55–56

6-pin IEEE 1394 400 connectors, 55–56

9-pin IEEE 1394 800 connectors, 55–56

A

action-safe margins, 205, 208

Add Media panel

capturing video and, 48, 49

importing from hard drive in, 64

importing image file with, 311–312

in Quick view/Expert view, 15–16

Add menu markers automatically for me check 

box, 256–257

Add New Event dialog, tagging clips and, 81

Add Places dialog, in Organizer, 79

Adjustments panel

adding visual content in, 268–269

adjusting size of, 44

applying effects from, 132

changing text properties in, 272–275

creating titles and, 204–205

modifying text in, 206–207

in Quick view/Expert view, 17–18

Volume adjustment in, 227

Adjustments tool, 21

Adobe Flash Video format for distribution, 293

Adobe Photoshop Elements 11

creating video-optimized file, 306

customizing title in, 307–311

importing file into Premiere Elements, 

311–312

sending photos from Organizer, 303–306

trial version of, 5

Adobe Premiere Elements 11

choosing project settings and, 35–36

Classroom in a Book, overview, 1–2

editing Photoshop image within, 312–314

home page/trial versions of, 5

images imported from Organizer to, 

303–306

new features in, 24–26

software installation, 3

Adobe resources, 4–5

AIFF files, SmartSound creating, 230

Align Objects commands, 210

Alignment options, in Transition Adjustments 

dialog, 187

Amount slider, in Applied Effects panel, 

164–165

analog video, converting to digital, 54

Anchor Point, in Motion effect, 155

animated thumbnail scene buttons, 270–271

animating effects

in Expert view, 17

with keyframes, 163–165

Animation tab, in Adjustments panel, 213

Anti-Aliasing quality, in Transition 

Adjustments dialog, 189

Anti-flicker Filter, in Motion effect, 155

Apple iPod/iPad/iPhone, exporting video to, 

294–295

Applied Effects panel

adjusting keyframes in, 169–170

adjusting size of, 44

applying effects from, 132–133

applying fade-ins/fade-outs in, 211–212

configuring Audio Effects in, 244

creating fade-outs in, 166–169

in Quick view/Expert view, 18

Shadow/Highlight effect in, 144, 145

Apply to all Marker Buttons button

animating buttons and, 271

modifying button text and, 274

Arrange commands, stacking order and, 

210, 216
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artistic effects, 135

At Each Scene radio button, 256–257

audio

adding narration, 231

adding to menus, 269

adjusting for multiple clips/

fades, 237

adjusting gain, 235–236

adjusting in Expert view/Quick 

view, 227–228

adjusting volume, 233–234

adjusting with SmartMix, 

237–239

Audio Mixer tool for, 241–243

Beat Detect Settings for, 243

distortion of, Normalization 

for, 236

importing from hard drive, 64

with SmartSound, 228–230

sound effects and, 244

varying with keyframes, 239–241

waveforms and, 232–233

Audio Codec list, for custom 

preset, 291

Audio Effects in Expert view, 244

Audio file format, exporting audio 

and, 294

Audio Mixer tool

adjusting volume/balance, 

241–243

in Tools panel, 22

Audio Transition Default Duration

adjustments to, 40

for default transitions, 191–192

Audio/Video track, Quick view, 97

Auto Edit check box, for 

InstantMovie, 90

Auto Fix button, lighting problems 

and, 139

Auto Save

preferences adjustments, 41

value of, 42

Auto-Analyzer

accessing, 85–86

manually running, 86–87

Smart Tagging and, 76

automatic marker settings, in Menu 

Theme panel, 255–257

Automatic mode, in Smart Trim 

Options window, 125

Automatic Playback quality, 

previewing effects and, 140–141

auto-play discs, 254–255

AVCHD camcorders

capturing video from, 49–50

Video Importer and, 51–53

AVCHD discs

burning, 278–281

creating with menus, 257–260

creating without menus, 254–255

disc quality options, 281

format for distribution, 293

formats for, 250–251

understanding, 249–250

AVI format for distribution, 293

B

Background audio track, 97

background images, customizing 

menus and, 269

background music track

with SmartSound, 228–230

waveforms showing, 233

backlighting, Shadow/Highlight 

effect for, 129, 143–145

Backslash (\) key

Quick view and, 13

showing entire project, 237

in SmartFix, 136

spreading images over 

timeline, 305

in timeline, 192

Basic Settings box, in Export Settings 

dialog, 291

Beat Detect Settings dialog, 

synchronizing music and, 243

Between clips option, for transition 

alignment, 187

Bitrate Settings, in Export Settings 

dialog, 291

Black Video option, in Project Assets 

panel, 72

Blu-ray Discs (BDs)

adding scene markers to, 251–253

burning, 278–281

creating with menus, 257–260

creating without menus, 254–255

disc quality options, 281

formats for, 250–251

understanding, 249–250

bonus video clip, creating button for, 

265–266

Border color option, in Transition 

Adjustments, 188–189

Border width option, in Transition 

Adjustments, 188

Break apart InstantMovie option, 92

Browser pane, Organizer, 11–12

Burner Location menu, in 

Publish+Share panel, 280

burners

compatible, 280

DVD or Blu-ray Disc, 250

burning DVD/Blu-ray/AVCHD discs

disc quality options, 281

steps for, 278–281

buttons, menu

changing text properties of, 

272–275

customizing size/location, 

271–272

overlapping, 272

buttons, Scene Marker

changing text properties of, 

272–275

modifying, 261–263

buttons, thumbnail scene

animating, 270–271

modifying, 261–263

C

calendar, in Media browser, 80

Capture panel, 59–61

capturing/importing video

capture options, 57–59

Capture panel for, 59–61

connecting devices for, 55–57

converting analog to digital, 54

debugging device control issues, 

62–63

device control for clips, 59

from hard drive, 64

interfaces for, 49–50

overview of, 48

with Video Importer, 50–53

Center Text icon

in Adjustments panel, 206

for rolling credits, 219

Change Settings dialog, 37

Change Text Color button, 274

Change Text dialog, customizing 

movie titles and, 259

Check the Build in Progress screen, 

web DVD and, 277

Choose a movie theme dialog, 

InstantMovie and, 90
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Choose Name dialog, for custom 

presets, 292

Classroom in a Book
copying lesson files from, 4

overview, 1–2

prerequisites for, 2–3

Clear existing menu markers check 

box, 256–257

Clip Gain dialog

adjusting audio gain in, 235–236

decreasing volume on multiple 

clips in, 237

clip-based import

Capture panel for, 59–61

device control for, 59

live video capture vs., 49–50

clipping, waveforms and, 235–236

clips

adding in Expert view, 112–113

adding in Quick view, 101–103

adding to menus, 267–269

after Smart Tagging, 87–88

applying default transition to 

multiple, 191–193

applying FilmLooks effect to, 

170–171

applying Smart Tags to, 86–87

copying and pasting effects 

from, 146

creating InstantMovie from, 

89–92

creating split edits, 126

deleting in Expert view, 115–116

deleting in Quick view, 104

gain control for multiple, 

235–237

Keyword Tags for, 83–85

merging two, 173–175

moving in Expert view, 114–115

moving in Quick view, 103–104

Organizer tool for, 75–76

perfecting with effects, 137–138

reframing with Motion effect, 

153–155

Split Clip tool functions with, 

107–108, 119–120

star ratings for, 82–83

suboptimal, Smart Trim and, 

122–125

superimposed, 171–173

superimposing titles over, 

214–217

tagging. See tagging clips

Time Remapping tool and, 

149–151

Timeline view of, 77

transferring to Premiere 

Elements, 88–89

trimming in Expert view, 

116–118

trimming in Project Assets panel, 

72–74

trimming in Quick view, 105–107

Collapse-Expand video track, 109

Color (RGB) Adjustment panel, 

138–139

Color Matte option, 72

Color Picker dialog

modifying menu button text 

in, 274

for transition borders, 189

Color Properties dialog

changing text color in, 209–210

in creating overlay titles, 215–216

comma (,) key, for adding clips, 113

Commit Current Operation check 

mark, image adjustment 

and, 307

Community Help, Adobe, 4–5

compatibility, of recordable disc 

formats, 251

compositing clips, Videomerge and, 

173–175

compressing video, 278–279

computer prerequisites, 2

connector line, fading to black and, 

166–169

Constant Power audio transition, 192

Constrain proportions, in Motion 

effect, 155, 172

Content-based scene detection, 

57–59

Copy option

in Applied Effects panel, 146

for transitions, 186

crawls, 219

Create button, for InstantMovie, 89

Create panel, 11, 12

Create Slideshow option, 120–122

Create Sub-Category panel, in 

Keyword Tags, 84

Create Warped Text icon, on Type 

Tools panel, 311

credits, rolling, 219–222

Cross Dissolve transitions, for 

multiple clips, 191–193

curative effects, 134

Current Time field, in Monitor 

panel, 116

current-time indicator (CTI)

adding clips in Expert view, 113

adding clips in Quick view, 102

in Monitor panel, 97, 98, 99

placing transitions and, 182, 

184, 185

in Project Assets panel, 72, 73

in rendering Work Area, 142

in Time Remapping tool, 151–153

in trimming clips, 105–107, 

116–118

custom keywords, Keyword Tags for, 

83–85

custom presets, for sharing video, 

289–292

Customize Mix button, in 

SmartSound, 230

Cut option, 104

cuts, defined, 181

D

default durations, 40

Default Roll title templates, 219

default still image durations, 305

Default Text title templates

in creating overlay titles, 214

in Titles & Text panel, 204

default transitions, for multiple clips, 

191–193

defragmentation, video import 

and, 57

Delete and close gap option

in Expert view, 120

in Quick view, 104

Delete audio option, 104

Delete effect icon, 145

Delete option for transitions, 186

Design Center, Adobe, 5

Developer Connection, Adobe, 5

device control

for capturing clips, 59

debugging problems with, 62–63

digital video production. See video 

production

digital video, converting analog to, 54

Dip to Black transition, 190

disc burners. See burners

Disc Burning Panel, 255
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Disc Layout workspace

changing menu appearance/

buttons in, 271–272

creating menus in, 258–260

modifying Scene Marker buttons 

in, 261–263

Preview Disc panel in, 257

disc-based playback, MPEG format 

for, 293

disc-burning for DVD/Blu-ray/

AVCHD discs, 278–281

discs, auto-play, 254–255

distortion of sound, Normalization 

for, 235–237

Drag & Drop an Effect on Clip(s), in 

My Presets folder, 147

drag-and-drop method, for adding 

clips, 101–103

drop zone, adding video to menu 

with, 269

DSLR cameras

capturing video from, 49–50

Video Importer and, 51–53

dual monitor workspace, 44

dual-layer recordable disc 

formats, 251

Duration option, in Transition 

Adjustments, 187

DV/HDV camcorders

Capture panel with, 59–61

connectors for, 55–56

device control and, 59

video capture options, 57–59

DVD-Videos

adding scene markers to, 251–253

burning, 278–281

creating with menus, 247, 

257–260

creating without menus, 254–255

formats for, 250–251

understanding, 249–250

E

Ease-In, in Roll/Crawl Options, 

220, 221

Ease-Out, in Roll/Crawl Options, 

220, 221

Easing In/Out check boxes, in Time 

Remapping tool, 152

Edit Layer Style, in text box, 310, 313

Edit with Premiere Elements status 

message, 13

Edit, in Photoshop Elements 

command, 312–314

editing preparation

customizing workspace, 29, 

43–44

finding optimal project setting, 

32–35

identifying correct setting, 38–40

manually choosing setting, 36–37

opening new project, 31–32

Premiere Elements choosing 

setting, 35–36

project preferences in, 40–42

project setting options, 31

setting startup preferences, 30

editing video. See video editing

Editor icon, Organizer, 12

educators, Adobe resources for, 5

Effects panel

Action bar accessing, 19

applying effects from, 131

Audio Effects in, 244

features of, 134

Halftone Pattern effect in, 308

effects, working with

adjusting keyframes in, 169–170

Adjustments panel for, 132

animating effects, 163–165

Applied Effects panel for, 

132–133

categories of, 134–135

changing playback speed, 

157–158

choosing/applying, 138–140

copying/pasting on timeline, 146

creating fade outs, 166–169

creating Pan & Zoom effect, 

158–162

creating Picture-in-Picture 

overlay, 171–173

Effects panel for, 134

FilmLooks effect in, 170–171

icons for controlling, 145

overview of, 131

perfecting clips with, 137–138

previewing/rendering, 140–141

reframing clips, 153–155

reframing images, 156–157

rendering Work Area and, 142

saving preset, 147

Shadow/Highlight effect in, 129, 

143–145

SmartFix and, 135–137

stabilizing shaky footage, 

147–149

Time Remapping tool and, 

149–153

toggle on/off, 136

Tools panel for, 133

Videomerge for, 173–175

Elements Organizer. See Organizer

End Off Screen, in Roll/Crawl 

Options, 220, 221

error messages, Capture panel 

and, 61

Events, tagging clips to, 80–82

Every X Minutes radio button, scene 

marker option, 256–257

Expert view

Add Media/Project panels in, 

15–16

adding clips in, 112–113

adding titles in, 202–203

advanced adjustments with, 20

animating effects in, 17, 163–165

Audio Effects in, 244

creating full-screen title in, 

203–205

creating slide shows in, 120–122

deleting clips in, 115–116

enabling scene detection in, 

57–59

features of, 8

HSL Tuner in, 26

initial movie viewing in, 96

moving clips in, 114–115

Picture-in-Picture overlay in, 

171–173

Smart Trim mode in, 122–123

SmartFix in, 135–137

Split Clip tool in, 119–120

timeline, 16–17

transitions in, 184–186

trimming clips in, 116–118

viewing movie in, 68–69

volume adjustments in, 227–228

Export Settings dialog, in 

Publish+Share panel, 290

exporting video. See also sharing 

movies

to mobile phones/players, 

294–295

as still images, 296–297

extra storage capacity, for video 

import, 57
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eye icon

Color (RGB) Adjustment and, 

138–139

with Shadow/Highlight 

effect, 144

toggle effect on/off with, 136

eyedropper icon, for transition 

border color option, 188

F

Face Frames, in Pan & Zoom effect, 

159, 162

Fade Out icon, in Opacity effect, 173

fade-ins

applying to title clips, 211–212

with single-sided transitions, 190

in thought bubble graphics, 219

fade-outs

applying to title clips, 211–212

with keyframes, 166–169

with single-sided transitions, 190

in thought bubble graphics, 219

Faux Widescreen template, in 

General folder, 269

File Transfer Protocol (FTP), output 

formats for, 293–294

Film & Video, in Presets list box, 306

FilmLooks effect

applying, 170–171

features of, 25, 135

Filters, in Photoshop Elements 

interface, 308

Fit Contents to available space check 

box, 280–281

Fit to Visible Timeline button

creating default transitions 

and, 192

in Expert view, 112

in Monitor panel, 98, 99

in Quick view, 101–103

focus frames, in Pan & Zoom effect, 

159–160

font size, in modifying titles, 

206–207

Force selected Project Settings on 

this project check box, 36, 37

format types, physical media, 

250–251

Forums, Adobe, 5

Forward/Reverse toggle, in Time 

Remapping tool, 151, 152

Frame Blending button, in Time 

Remapping tool, 153

frames per second

in choosing project setting, 40

full frame rate and, 100

timecode and, 101

frames, exporting as still images, 285, 

296–297

Freeze Frame tool

exporting frames and, 285, 

296–297

in Tools panel, 21

FTP (File Transfer Protocol), output 

formats for, 293–294

full-screen titles

adding/editing, 202–203

creating, 203–205

G

gain adjustments, 233, 235–236

Garbage Mattes, in Effects panel, 175

General folder, in Titles & Text 

panel, 201

General Preferences panel, 40

geotagging, in Organizer, 67, 76–80

Get Media button, for loading 

videos, 10

Get Photos and Videos from Files 

and Folders dialog, 10

Go to Next Edit Point button, in 

Monitor panel, 98, 99

Go to Previous Edit Point button, in 

Monitor panel, 98, 99

Gradient list box, in Color Properties 

dialog, 209

Graphics panel

Action bar accessing, 20

adding speech bubbles and, 

217–219

green scene marker, in Menu Marker 

panel, 253

H

Halftone Pattern effect, in Effects 

panel, 308

hard drive

importing content from, 64

sufficient space in, 57

HD NTSC preset, web DVD and, 276

height of tracks, changing, 110

Help and Support, Adobe, 5

high data transfer rate, 57

Highlight Amount slider, in Shadow/

Highlight effect, 144

History panel, 23

Hold Time dialog, Pan & Zoom effect 

and, 162

Home key

adding clips and, 102

previewing video and, 100

trimming clips and, 105

Horizontal Type Text tool, 308

Horizontal Type tool

in Adjustments panel, 204–205

in changing text color, 209

in creating rolling credits, 219

modifying text with, 206

HSL Tuner, 26

I

IEEE 1394 port, video import and, 

55–57

Image file format, 294

image thumbnails

Organizer displaying, 303–304

Scene Marker button, 261–263

In points

for thumbnail videos, 270–271

in trimming clips, 105, 116

Inflate option, in Style drop-down 

list, 311

Info panel, 22–23

Insert icon, for titles, 202

Insert in Movie option, in Freeze 

Frame dialog, 296

installation of Adobe Premiere 

Elements 11, 3

Instant Movie panel, accessing, 19

InstantMovie, creating, 89–92

Insufficient media transition 

message, 194–195

Interest Level, in Smart Trim 

Options, 124

interface, Premiere Elements

Action bar and, 19–20

Add Media/Project panels for, 

15–16

Adjustments/Applied Effects 

panels in, 17–18

Adobe Premiere Elements and, 8

for capturing video, 49–50

configuring dual monitors, 44

customizing, 29, 43–44
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Info/History panels in, 22–23

Monitor panel in, 17

Organizer for, 11–14

Publish+Share panel in, 22

Quick view/Expert view 

timelines, 16–17

Tools panel in, 21–22

workspace, 9–10

interlaced format, project settings 

and, 39

intersecting point, transitions and, 

194–195

iPhone cameras, capturing video 

from, 47, 49–50

iPod/iPad/iPhone, Apple, exporting 

video to, 294–295

J

J-cuts, 126

K

keyframes

adjusting, 169–170

animating effects with, 163–165

creating fade outs with, 166–169

varying volume with, 239–241

Keyword list box, in SmartSound, 

229, 230

Keyword Tags

customizing keywords with, 

83–85

organizing videos with, 12

L

Labs, Adobe, 5

L-cuts, 126

Left clip option, for transition 

alignment, 187

Length box, in SmartSound, 229, 230

Lesson Files folder, copying from 

DVD, 4

letterboxes

eliminating, 156–157

incorrect project settings and, 33

Limit To Zoom check box, in 

Applied Effects panel, 148

List view, tagging clips to Places 

with, 80

Lithos Pro style, in Text tool options 

bar, 309

live video capture

clip-based import vs., 49–50

connectors for, 55–56

loudness

adjusting, 233–234

decreasing on multiple clips, 237

Normalization of distortion, 236

M

Macintosh computers, output 

formats for, 293–294

Magnification, Motion effect and, 

154–155

Main Menu Marker, Outtake button 

in, 266

main menu markers, 267

Main menu, from Menu Theme 

panel, 258–260

Maintain Audio Pitch check box, in 

Time Stretch tool, 158

manual addition of scene markers, 

251–253

manual choice of project settings, 

36–37

manual creating of Events, 81–82

Manual mode, in Smart Trim 

Options window, 125

manual running of Auto-Analyzer, 

86–87

Map view, in tagging clips to 

Places, 80

Marker buttons

animating, 270–271

changing text properties of, 

272–275

modifying, 261–263

Marker Type menu, Stop Marker 

in, 264

Marketplace & Exchange, Adobe, 5

Media browser

content grouped by date in, 80

Sort By list box in, 304

viewing videos/still images in, 77

Media Cache, deleting files in, 42

Media Duration column head, 71

Menu Background Adjustments 

panel

animating Marker buttons in, 

270–271

customizing menus in, 269

Menu Background box, adding visual 

content and, 268–269

menu buttons

changing text properties of, 

272–275

customizing size/location, 

271–272

overlapping, 272

Menu Marker panel

green scene marker in, 253

modifying Scene Marker buttons 

in, 262–263

Stop Marker in, 264–265

menu marker types, 267

Menu Theme panel

creating menus in, 257–260

scene marker options in, 255–257

Menu Titles, changing text properties 

of, 272–275

menus

adding audio clips to, 269

adding stop markers, 264–265

adding visual content to, 267–269

changing appearance/buttons in, 

271–272

creating, 257–260

producing discs without, 

254–255

mini-timeline, in Vignetting effect, 

164–165

Mismatched Project Settings Preset, 

Video Editor function and, 13

Missing Disc Menu, 254

Mix button, in SmartSound, 230

mobile phones, exporting video to, 

294–295

Monitor panel

adjusting size of, 43–44

centering text in, 207

functions of, 14, 17

images displayed in, 305

playback controls in, 92

previewing effects in, 140–141

title-safe/action-safe margins 

in, 208

video editing in, 97–100

Motion adjustment, in Applied 

Effects panel, 18

Motion effect

reframing clips with, 153–155

reframing images with, 156–157

motion effects, 135

Motion Menu Buttons, setting 

duration of, 270
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Movie Menu tool

Outtake button and, 266

in Tools panel, 21

Movie Title Here, in Disc Layout 

workspace, 259

movies, sharing

choosing targets for, 286

exporting frames as still images, 

285, 296–297

output formats for, 293

on personal computers, 289–292

sending to mobile phones/

players, 294–295

uploading to YouTube, 287–289

MPEG format for distribution, 293

Music box, for InstantMovie, 90, 91

Music panel

Action bar accessing, 20

for SmartSound, 228

music tracks, with SmartSound, 

228–230

N

Name column head, in Project Assets 

panel, 71

Name field, in Menu Marker 

panel, 262

names, for theme marker labels, 

261–263

narration

adding, 231

Normalized, 235–237

waveforms and, 118, 232–233

Narration tool, in Tools panel, 21

Narration track

adjusting audio gain in, 235–236

adjusting volume in, 233–234

Quick view, 97

Navigational buttons, changing text 

properties of, 272–275

New Folder option, in Project Assets 

panel menu, 71

New Frame button, in Pan & Zoom 

effect, 161

New Item option, in Project Assets 

panel menu, 72

New Project screen

choosing project settings in, 

36–37

options in, 31

Newsreel effect, 170–171

Next Scene control, capturing clips 

and, 59

Normalization

audio distortion and, 235–236

increasing volume and, 236

volume adjustments and, 234

O

Old Film effect, 171

Opacity controls

in Applied Effects panel, 18

creating fade-ins/fade-outs, 

211–212

fading to black and, 166–169

Organizer

after Smart Tagging, 87–88

Auto-Analyzer function in, 85–87

creating InstantMovie in, 89–92

importing video footage and, 10

Keyword Tags in, 83–85

loading videos files in, 9–10

Premiere Elements importing 

photos from, 303–306

sending videos for editing in, 

12–13

setting up, 11–12

star ratings in, 82–83

tagging clips to Events, 80–82

tagging clips to Places, 67, 76–80

tagging techniques in, 75–76

transferring clips from, 88–89

Out points, trimming clips and, 

105, 116

Outtake button, in main menu, 

265–266

overlapping buttons, 272

overlay edits, 204

overlay effects, 134

overlay titles

adding/editing, 202–203

creating, 214–217

overscan, 208

Owned Titles, in SmartSound, 

229, 230

P

Pan & Zoom tool

applying effects from, 133, 134, 

158–160

in Choose a movie theme 

dialog, 90

customizing, 160–162

in Tools panel, 21

Pan Time dialog, 161

Paste Effects and Adjustments 

option, reframing images 

and, 157

Paste option

in Applied Effects panel, 146

for transitions, 186

personal computers, sharing videos 

on, 289–292

Photo Browser, Organizer, 304

Photoshop Elements 11. See Adobe 

Photoshop Elements 11

physical media, format types for, 

250–251

Picture-in-Picture (PiP) overlay., 

171–173

Places, tagging clips to, 78–80

Play button(s)

changing text properties of, 

272–275

in Disc Layout workspace, 

259–260

to preview transition, 188

Playback quality, previewing effects 

and, 140–141

PlayStation Portable, exporting video 

to, 294–295

Postroll, in Roll/Crawl Options, 221

Preferences dialog, adjustments to, 

40–42

Premiere Elements 11. See Adobe 

Premiere Elements 11

prerequisites

computer, 2

skills, 2–3

Preroll, in Roll/Crawl Options, 

220, 221

presets

creating customized, 289–292

identifying correct, 38–40

for uploading to YouTube, 288

Presets list box

creating web DVD and, 276

Film & Video in, 306

in Video Importer, 53

Preview Disc window

in Disc Layout workspace, 257

previewing main menu, 260

updated names/thumbnails 

in, 263
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Previous Scene control, capturing 

clips and, 59

product home page, Premiere 

Elements, 5

progressive format, in project 

settings, 39

Project Assets panel

bonus video clips in, 265

creating slide shows in, 120–122

dragging clips into, 88

in Expert view, 15–16

functions of, 70–74

initial movie viewing in, 96

inserting title into movie in, 312

minimizing, 171, 174

opening, 69

video editing and, 111

project preferences, adjustments to, 

40–42

project settings

finding optimal, 32–35

identifying correct, 38–40

manually choosing, 36–37

opening new project, 31–32

options for opening, 31

Premiere Elements choosing, 

35–36

Publish+Share panel

creating auto-play discs, 254–255

exporting to mobile phones/

players with, 294–295

features of, 22

selecting Disc in, 279

selecting web DVD in, 275

sharing on personal computers 

with, 289–292

sharing/exporting video and, 286

uploading to YouTube with, 288

Q

Quality Level, in Smart Trim 

Options, 124

Quick view

Add Media/Project panels in, 

15–16

adding clips in, 101–103

adding titles in, 202–203

deleting clips in, 104

features of, 7, 8

four tracks in, 97

moving clips in, 103–104

Split Clip tool in, 107–108

timeline, 16–17

transitions in, 182–183

trimming clips in, 105–107

Video Editor function and, 13–14

video effects with, 20

volume adjustments in, 227–228

working in Monitor panel, 

97–100

QuickTime format

features of, 294

sharing on personal computers 

in, 289–292

R

Ratings bar, in Media view, 82–83

rearrange pointer, moving clips 

and, 114

reconfiguring transition settings, 185

recordable disc formats, 250–251

reframing clips, 153–155

reframing images, 156–157

Render Preview option, for 

InstantMovie, 91

Rendering dialog, previewing videos 

and, 141

replacing transitions, 185

Reset icon, 145

resolution

in choosing project settings, 

38–39

options, disc-burning and, 281

uploading to YouTube and, 288

resources, Adobe, 4–5

Reverse check box, in Transition 

Adjustments dialog, 189

Reverse Speed check box, in Time 

Stretch tool, 158

rewritable disc formats, 250–251

Right clip option, for transition 

alignment, 187

rolling credits

changing speed of, 221–222

creating, 219–221

rollover effects, 260

Rotation controls, in Motion 

effect, 155

Run Auto-Analyzer function, in 

Browser pane window, 12

Run Auto-Analyzer option, 

Organizer, 86

S

safe zones, for titles, 208, 259

Save in Version Set with Original 

check box, 313

Save Preset dialog, in Applied Effects 

panel, 147

Scale slider, in Applied Effects 

panel, 172

scaling text boxes, 271

scene detection, video capture 

options and, 57–59

Scene Marker buttons

animating thumbnails, 270–271

changing text properties of, 

272–275

modifying, 261–263

scene markers

automatically generating, 

255–257

features of, 267

manually adding, 251–253

Scene Selection menu, from Menu 

Theme panel, 258

Scenes menu

animating image thumbnails in, 

270–271

in Disc Layout workspace, 

259–260

scissors icon, Split Clip tool and, 108, 

119–120

ScratchDisks preferences, 

adjustments to, 41

scrubbing through videos, 99

SD card, Video Importer and, 51–53

SD High Quality NTSC preset, web 

DVD and, 276

SD Medium Quality NTSC preset, 

web DVD and, 276

Sequence box, for InstantMovie, 91

Set In/Set Out icons, in Project 

Assets panel, 72, 73, 74

Set Selected as Default Transition, in 

Cross Dissolve transition, 191

Shadow/Highlight effect, 129, 

143–145

Share panel, 11, 12

Share WorkArea Bar Only check box

sharing on personal computers 

and, 292

uploading to YouTube and, 288
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sharing movies

choosing targets for, 286

exporting frames as still images, 

285, 296–297

output formats for, 293

on personal computers, 289–292

sending to mobile phones/

players, 294–295

uploading to YouTube, 287–289

Sharpen effect, 154

Show Overlapping Menu Buttons, in 

Disc Layout workspace, 272

Show Safe Margins, enabling, 272

Show/Hide keyframe controls icon, 

in Applied Effects panel, 18, 

133, 164, 165

Show/Hide toggle, for showing 

Audio, 231

Shuttle control, capturing clips 

and, 59

single-sided transitions, 190

Size value, in Adjustments panel, 207

Sketch, in Photoshop Elements 

interface, 308

skill prerequisites, 2–3

slow-motion effects, Time 

Remapping tool and, 151–153

Smart Events, Organizer, 80

Smart Fix control, in Adjustments 

panel, 132

Smart Fix dialog, Video Editor 

function and, 13

Smart Mix tool, 21

Smart Tags

applying to clips, 86–87

features of, 12

of video clips, 76

Smart Trim mode

features of, 122–123

operating modes for, 125

options in, 124

in Tools panel, 21

SmartFix control

in Adjustments panel, 18

in Quick view, 17

utilizing, 135–137

SmartMix, adjusting volume with, 

237–239

SmartSound Express Track, 228–230

snapshot export function, 296–297

Sonicfire Pro, 229

Sony PlayStation Portable, exporting 

video to, 294–295

Sort By list box

in Organizer's media browser, 11

selecting Newest in, 304

sound. See audio

sound effects, 244

soundtracks

creating with SmartSound, 

228–230

marking beat detection and, 243

source, in choosing project 

settings, 38

speech bubbles, 199, 217–219

Speed and Intensity box, for 

InstantMovie, 90, 91

speed controls

applying effects with, 135

Time Remapping tool and, 

149–153

Time Stretch tool, 157–158

speed, rolling credits and, 221–222

Split Clip tool

in Expert view, 119–120

functions of, 107–108

split edits, 126

Split Tone effect, 26

Stabilizer effect, 147–149

star ratings, organizing clips by, 

82–83

Start Off Screen, in Roll/Crawl 

Options, 220, 221

Start/end points, in Transition 

Adjustments dialog, 179

in Transition Adjustments 

dialog, 188

startup preferences, setting, 30

Step Forward button, in Monitor 

panel, 98, 99

Still Image Default Duration

in General Preferences panel, 40

titles and, 202

still images

adding to menus, 269

exporting frames as, 285, 

296–297

importing into titles, 210–211

from Organizer to Premiere 

Elements, 305

reframing, 156–157

stop markers

adding, 264–265

features of, 267

stop-motion, 53

stopwatch icon, 145, 164

storyboard-style editing, 101

Style list box, in SmartSound, 

229, 230

Style Settings dialog

customizing text with, 310

Select stroke color dialog, 313

Style tab, in Adjustments panel, 

206–207

submenus, creating, 264–266

superimposed clips, 171–173

superimposed titles, 214–217

T

tagging clips

after Smart Tagging, 87–88

to Events, 80–82

Keyword Tags for, 83–85

Organizer techniques for, 75–76

to Places, 76–80

Smart Tags for, 86–87

star ratings for, 82–83

Tagging Search window, 84–85

Tags/Info icon

for Keyword Tags, 83

in Organizer's media browser, 

11, 12

tape-based camcorders

Capture panel for, 59–61

capturing video from, 49–50

connectors for, 55–56

device control and, 59

video capture options, 57–59

Video Importer and, 51–53

Temperature and Tint 

adjustments, 25

templates

Default Roll title, 219

Faux Widescreen, 269

menu, modifying titles for, 

261–263

text

animations, 213

centering, 207

changing alignment/style/size, 

206–207

changing color of, 209–210

customizing in Adobe Photoshop 

Elements, 308–311

customizing in menus, 271–272

customizing in movie titles, 259

modifying in menu buttons, 

272–275
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rolling credits as, 219–222

in thought bubble graphics, 

218–219

Text tool options bar, Lithos Pro style 

in, 309

Theme Content box, for 

InstantMovie, 91

Theme Music radio button, for 

InstantMovie, 90, 91

Thought and Speech Bubbles 

category, in Graphics panel, 

199, 217–219

Thumbnail Offset section, in Menu 

Marker panel, 262

thumbnail photos, Organizer 

displaying, 303–304

thumbnails, Scene Marker button

animating, 270–271

modifying, 261–263

Time Remapping tool

features of, 24, 133, 149–151

in Tools panel, 21

for variable-speed/slow-motion 

effects, 151–153

Time Stretch tool

changing playback speed, 

157–158

in Tools panel, 22

timecode

function of, 101

in Pan & Zoom effect, 161

timecode box, transition duration 

and, 186

Timecode-based scene detection, 

57–59

time-lapse video, 53

timeline

adding stop markers in, 264–265

adding/deleting/changing height 

of tracks in, 110

adjusting keyframes in, 169–170

copy/paste effects on, 146

creating fade outs in, 166–169

customizing track views in, 111

manually placing markers in, 

251–253

Quick view and Expert view, 

16–17

rendering Work Area in, 142

selecting still images in, 305

Timeline panel, 14

Timeline view, of clips, 77

TimeZones, Time Remapping tool 

and, 149–153

Title track, Quick view, 97

Title window, in SmartSound, 

229, 230

titles

adding images to, 210–211

adding/editing, 202–203

animating, 213

applying fade-ins/fade-outs to, 

211–212

centering elements in, 207

changing text color in, 209–210

creating full-screen, 203–205

creating overlay, 214–217

customizing, 259

customizing in Photoshop 

Elements, 307–311

importing into Premiere 

Elements, 311–312

inserting into movie, 312

modifying text in, 206–207

rolling credits as, 219–222

templates for, 201

viewing time for, 211

Titles & Text panel

Action bar accessing, 19

creating full-screen titles in, 

204–205

creating overlay titles in, 214–217

creating rolling credits in, 

219–222

title templates and, 201

title-safe margins

buttons and titles in, 272

positioning titles and, 205, 208

Toggle animation (create keyframes) 

icon, 145, 164

Toggle the effect on or off (eye icon)

Color (RGB) Adjustment and, 

138–139

with Shadow/Highlight 

effect, 144

toggle effect on/off with, 136

Tools panel

Action bar accessing, 19

applying effects from, 131, 133

features of, 21–22

Video Editor in, 304

Total Markers radio button, 256–257

track size, in timeline, 166

tracks

adding/deleting/changing height 

of, 110

customizing views of, 111

Transition Adjustments dialog

choosing preferred location 

in, 184

configuration options in, 179, 

183, 185, 187–189

single-sided transitions in, 190

transition duration, changing, 305

transitions

adding fade-ins/fade-outs 

with, 190

applying default to multiple clips, 

191–193

in Expert view, 184–186

explained, 181

proper utilization of, 193–194

in Quick view, 182–183

trimmed frames for, 194–196

viewing properties of, 186–189

Transitions panel, accessing, 19

trashcan icon. See Delete effect icon

trial versions of Premiere Elements/

Photoshop Elements, 5

Trim view, in Monitor panel, 106, 

112, 117

trimming video

in Expert view, 116–118

in Project Assets panel, 72–74

in Quick view, 105–107

Smart Trim mode and, 122–125

for transitions, 194–195

TV, Adobe, 5

U

Universal Serial Bus (USP) drive, 

output formats for, 293–294

universal toggle animation button, in 

Applied Effects panel, 165

Unlink Audio and Video option, for 

split edits, 126

uploading to YouTube, 287–289

uploading web DVD files, 278

V

variable-speed effects, with Time 

Remapping tool, 151–153

video capture. See capturing/

importing video
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video clips. See clips

Video Codec list box, creating 

custom presets and, 290

video conversion, from analog to 

digital, 54

video editing

adding clips in Expert view, 

112–113

adding clips in Quick view, 

101–103

creating slide shows, 120–122

creating split edits, 126

deleting clips in Expert view, 

115–116

deleting clips in Quick view, 104

initial movie viewing, 96

in Monitor panel, 97–100

moving clips in Expert view, 

114–115

moving clips in Quick view, 

103–104

Smart Trim mode for, 122–125

Split Clip tool in Expert view for, 

119–120

Split Clip tool in Quick view for, 

107–108

trimming clips in Expert view, 

116–118

trimming clips in Quick view, 

105–107

Video Editor

function in Organizer, 12–13, 304

opening Existing Project in, 32

Video Importer, 50–53

video production

Action bar and, 19–20

Add Media/Project panels for, 

15–16

Adjustments/Applied Effects 

panels in, 17–18

Adobe Premiere Elements and, 8

Info/History panels in, 22–23

Monitor panel in, 17

Organizer for, 11–14

Publish+Share panel in, 22

Quick view/Expert view 

timelines, 16–17

Tools panel in, 21–22

workspace for, 9–10

video sharing

choosing targets for, 286

exporting frames as still images, 

285, 296–297

output formats for, 293

on personal computers, 289–292

sending to mobile phones/

players, 294–295

uploading to YouTube, 287–289

video standard options, disc-burning 

and, 281

Video Transition Default Duration

adjustments to, 40

for default transitions, 191–193

Videomerge, compositing clips with, 

173–175

Videos button, Text subsection 

of, 273

Vignetting effect

in animating effects, 163–165

features of, 24

volume adjustments. See also audio

in Adjustments panel, 227

with keyframes, 239–241

mechanisms for, 233–234

W

Warp Text dialog, Style drop-down 

list in, 311

WAV files, SmartSound creating, 230

waveforms

in Narration track, 118

seeing audio files as, 227

viewing/understanding, 232–233

web DVDs

creating, 275–278

understanding, 250

webcams

capturing video from, 49–50

connectors for, 55–56

video capture options, 57–59

websites, format for distributing 

from, 293

Welcome screen

features of, 9

opening new project from, 30, 35

Windows Media files for 

distribution, 293

Work Area

rendering, 142

restoring to complete project, 185

Y

YouTube, uploading video to, 

287–289

Z

Zoom In button, in Monitor panel, 

98, 99, 109

Zoom Out button, in Monitor panel, 

98, 100

Zoom slider, in Monitor panel, 
98, 100
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